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Introduction

AnetHelpTool is a software tool for the creation of Help systems for MS WINDOWS-based 
applications.    It provides an easy and pleasant development process which saves time and 
increases your help-writing efficiency.    It also greatly simplifies design since the program is fully
WYSIWYG and looks exactly like an actual help file.

To create output file (in .HLP format) the external Help Compiler 3.1 is used.    This Help 
Compiler is part of most    programming systems designed for creating WINDOWS applications.  
The Help Compiler uses two input file formats: .RTF format for data and .HPJ format for project  
files.    Both these files are generated by AnetHelpTool.    To support linking of the created Help 
file with user's programs AnetHelpTool also creates include file of .H format.      

AnetHelpTool has its own internal word processor based on multifont and multicolor text box 
control (ALLText control), which provides full WYSIWYG on-line presentation.    It's engine 
provides easy creation of all necessary files you may need to make a professional help file. 



Creation of a Help File

A Help file provides users with information about an application.    Using AnetHelpTool, the 
creation of a Help file for a Windows application is accomplished by the following major tasks:

Gathering information for the Help topics and planning the Help file.
Writing the text for the Help topics.
Making all required reference links. 
Building the Help    file. 
Testing and debugging the Help file.
Programming the application so that it can access Windows Help.



How to Include Fonts and Colors

First select the text you wish to have in a different font or color.    Then select Font command 
from the Format    Menu.    A dialog box will appear, offering a choice of Fonts, character sizes, 
and attributes such as Regular, Bold, Italic, and Bold Italic.    After you have made your choice 
select OK or select Cancel to quit. 

There is the ability to save existing fonts quickly and assign these stored font attributes to 
selected text:

    To save font locate cursor to text with this font and press Ctrl-[0...9], for example Ctrl-1 or 
Ctrl-2.    In this way you can save attributes of ten fonts in the computer memory.

    To assign stored font attributes to some text, select this text and    press Alt-[0...9].    Digit 
should correspond to previously stored font.    For example if you store font by pressing Ctrl-5, 
you can assign these font attributtes by pressing Alt-5.

In order to change the color of a selection, choose Color command from Format menu.    
Choose any color from the Color Palette presented.    Then press OK. 

Note: 
1. All options described above are also available from the buttons on the toolbar.    Their 
functions are obvious from their symbols. 
2. Once you have changed font attribute the font keeps the new feature thereafter until you alter
it again.    But if the cursor touches a text portion which has different attributes, the font 
automatically shares these new features.    The leftmost Font button in the toolbar continuously 
displays the font of the text portion on which the cursor is located. Each time you Create the 
New Window, the font will display the last fixed features.



Making and Removing Links

Before you can create reference links you must create at least one Topic.    In order to make a 
reference link, select the text or graphic reference (bmc,bml or bmr)    that you wish to make 
the activator by dragging the cursor over it with the left button pressed.    Then    choose To Topic
command from Link menu to load Create New Link dialog box , this allows you to link selected 
phrase with desirable topic.

If you select To Program instead of To Topic in the procedure described above,    AnetHelpTool 
will link the selected text with any external executable file (which has .BAT, .COM, .EXE or .PIF 
extension).

You may check the validity of the link created both in Design and Runtime modes.    As long as 
you are in Design mode, put the cursor on the hotspot and choose Jump command from the 
Link menu.      This will cause a jump to the destination topic.    In order to remove the existing 
link, highlight the whole hotspot and choose Remove command    from the Link menu. 

The Runtime mode is convenient for quick    Testing of a Help Project prior to compiling it.    In 
Runtime mode, double clicking the hotspot will cause a jump to the destination topic. 



Inserting Graphical Objects

AnetHelpTool supports the following graphical formats:
bitmap (with .bmp extension)
metafile (.wmf)
hypergraphic (.shg)
multiple resolution bimap (.mrb)

You can include graphical images in your help file using the Insert Object command from the 
Edit menu.      In order to insert graphical object, place the cursor where    you want the graphic 
to appear and select Insert Object command  or click the Insert Object button on the toolbar. In 
Insert Object dialog box enter graphic's file name, select    the method for including graphic and 
press OK button.

There are two methods for including grahpics in Help file:

 Embed bitmap or metafile directly in the topic text as OLE object.
In this case you can see the graphic in the topic text, but you can't wrap text around this 
graphic (it is treated the same as a character).    To modify this graphic you must edit it in 
your graphic application and then reimport it into AnetHelpTool.      Also you must have OLE 
server that allows embed graphic in topic text (to embed .BMP files you should have MS 
PBRUSH, and for embedding .WMF files - CorelDraw for example).    

 Create graphic reference in topic text.
In this case you can't see the graphic in AnetHelpTool topic text, but you have the widest 
range of options for displaying text and graphics.    You can treat graphic as a character or 
wrap text around the graphic's left or right edge.    You can include hypergraphics (created 
with the Hotsport Editor) only by reference.    Including the same graphic by reference in 
several places in your topic file adds only one copy of graphic in the compiled Help file.    For 
correct compilation of referenced graphics you should enter location of graphics files in 
Option dialog box.

For creating graphic reference the following syntax is used:

{command filename}

You can use three commands in graphic reference.

bmc    - Aligns graphic as a character.
bml     - Aligns the graphic at the left margin of text; text wraps along the graphic's right edge.
bmr    - Aligns the graphic at the right margin of text; text wraps along the graphic's left edge. 
The filename should include only file name, not the file's full path.



How to Edit Topic Attributes

If you want to change any aspect of a Topic, for example, alter the Keywords, or change the 
Context String, select Attributes command from the Topic menu.    A dialog box will 
appear with the option to edit the item.    All of the items refer to the current topic.    You
can access the aspects of any other topic just by selecting its title in Topic list and thus
making it the current topic. 

Each topic may have a number of keywords related to it.    There are two list boxes in a 
dialog box.    One of them (Keywords List) contains a list of all existing keywords of the
Help system.    The other list box (Topic Keywords) contains the keywords related to 
the topic being edited.    You can move any keyword to a different box using the arrows
in between.    If there is no appropriate keyword you can add it by clicking    Add    
button.    In the dialog box fill in the new keyword you wish to add and press OK. 

If you decide to remove a keyword from your Help project, select one from Keywords List 
and press Delete. Delete button affects only that list box.    Once you have pressed 
Delete the keyword will be detached from all topics which it previously related to and 
be removed. 

See also Topic Attributes Dialog Box.



Paragraph Formatting

It is convenient to set the tabulation for a text portion you want to display as a table.    You can 
do so either by choosing Tabs command from Format menu or using the mouse. To perform it 
through the menu call the Tabs dialog box.    If you want a table with the regular field spaces set 
the Default Tab Stops value.    Each time you press the tabulation button, the cursor will jump to 
the nearest Tab Stop position.    If you are going to make irregular Tab Stops, in the Tab Stop 
Position text box define the number for the position where you want to jump when pressing the 
tabulation button.    Every entry should be collected in a list box by pressing Set button.    The 
ruler under the toolbar helps you to choose the number correctly.    These numbers correspond 
to those on the ruler.    For example, the numbers 3 and 7 in the Tab Stop Position list box mean 
the cursor will jump to the places which correspond to the projections of those values of the 
ruler when you press the tabulation button twice consecutively.    Depending on the Alignment 
section setting (left, right or centered) the text can be typed to the left, right or centered from the 
Tab Stop position.      After the cursor has passed your last random Tab Stop position the Default 
setting will work.    Note, the default setting is not indicated by the Tab Stop markers.

It is much easier and faster to set the random Tab Stops with the mouse.    First set the Tab Stop
alignment type you want (left, right or center) by clicking left mouse button on the indicator at the
beginning of the ruler.    Then click the left button anywhere on the ruler to set the specified Tab 
Stop.    Every Tab Stop can have a different alignment type.    To remove a particular marker just 
click on it with the right mouse button. 

The Paragraph command from Format menu enables you to specify general and first line 
indentation in various space units (centimeter or inch).    It also provides paragraph interspace 
settings and paragraph alignment type.    These alignment types are also available from the 
buttons on the toolbar.    Their functions are obvious from the symbols on the buttons.

In order to align paragraph it is necessary to anchor the cursor on the paragraph.    Then choose
the way you want to align.    Use Paragraph command from Format menu or choose appropriate
alignment button from the toolbar to make    paragraph(s) align specifically. 

 AnetHelpTool provides the following ways of alignment:

Centered
Justifited
Left justified
Right justified

See also Paragraph dialog box.



How to Remove a Topic

To delete a topic(s) from your project, select Delete command from Topic menu.    A Delete 
Topic(s) dialog box will allow you to collect titles of topics you wish to remove in a Remove 
Topic(s) list box.      All titles of topics available are presented in a Topics List box.    You can 
direct any title from box to box using arrows located in between.

You can preview any topic selected if you press Preview button.    The Preview window is 
somewhat static and doesn't alter during scrolling through topic titles.      Any time you want to 
refresh this window press Preview. 

To confirm your choice press OK.    Once you press OK the topic and all interrelated links will be 
deleted.      



Runtime Testing

AnetHelpTool provides very convenient and time saving hot testing technology of Help projects 
in WYSIWYG    presentation without running Help Compiler.    Select Runtime command from 
Mode menu.    Double clicking on a hotspot will cause a jump to the destination topic, display of 
a pop-up window or running an external executable program just as will an actual Help file. 



Making Help File

In order to    create an output file (in .HLP    format), the external Help Compiler is used.    The 
Help Compiler uses two input file formats: .RTF format for data and .HPJ    format for project 
files.    AnetHelpTool automatically generates both these files prior to running the Help compiler.  
Also in order to support linking of the created Help file with the user's    program,    AnetHelpTool 
creates an include file in .H format.

When a topic file has been prepared it is very easy to make the Help file.    First switch to 
Runtime Mode.    Then the Compile menu will be accessible.    Select Batch Processing 
command in Compile menu.      AnetHelpTool will automatically produce all necessary input files 
for the Help Compiler, create include file, run Help Compiler to make the output Help file and run
WinHelp.exe in order to display the last generated help file. 

If you wish to make help file step-by step, choose Create RTF, HPJ and H Files, Compile and 
Run WinHelp commands successively.

Each time you perform these actions AnetHelpTool deletes the previous intermediate files.    
Cycling the help authoring system restores these documents.    You don't need to update the 
files.    It will be done automatically. 



Creation of a New Topic

To make a help file you must have created at least one Topic.    To create a new topic choose 
New command from Topic menu.    The Topic Attributes dialog box will appear.    Each topic is 
specified by its Title, Context String and a Keyword and the presence of a nonscrolling region.    
For best use of AnetHelpTool's potential it is a good idea to fill in all the topic attributes.    By 
default "Title n" and "Context_String_n" (where n is a successive integer) will be assigned to the
"Topic" and "Context String" text boxes respectively.    If you decide to display the topic as a pop-
up window be sure not to choose "Nonscrolling region" check box.    Otherwise only the 
nonscrolling area will be displayed. 

Each topic may have a number of keywords related to it.    There are two list boxes in a dialog 
box.    One of them (Keywords List) contains a list of all existing keywords in the Help system.    
The other list box (Topic Keywords) contains the keywords related to the    topic being edited.    
You can move any keyword to a different box using the arrows in between.    If there is no 
appropriate keyword you can add it by clicking    Add    button.    In    the dialog box fill in the new 
keyword you wish to add and    press OK. 

Press Close if you wish to complete the new topic.    An empty window will appear which is the 
new topic space.    You can type in and edit your material for that topic.

Note: AnetHelpTool considers the first    topic created as a contents screen.    The Contents 
screen appears first when Help file is run. 



How to Launch a program

You can run programs from within your Help file.    A program can be launched by creating a 
hotspot link using a word, phrase or graphic reference (bmc,bml or bmr).    Select the text or 
graphic reference using the left mouse button, then choose To Program command from    Link 
Menu.    You will be presented with a Link to Program dialog box requesting the program details. 
Enter the program name or choose it browsing.    After pressing OK the selected text will 
become hotspot which appear green and underlined.    The cursor pointer becomes a 
handshape when going over a hotspot and in a bottom window the destination topic title 
appears. 



Help Topic

A Help topic is a distinct unit of information.    Windows Help displays only one topic at a time.    
A user can view any topic in a help file by using a link to the topic or searching for keywords 
associated with the topic.    Within a Help topic, there may be one or more jumps on which you 
can click to display another Help topic.    A Help topic file typically contains multiple Help topics.



Topic Title

Typically every    topic should have a name (title).    AnetHelpTool uses titles to present the topics
in a number of dialog boxes.    Topic titles can be up to 80 characters in length.    Strings longer 
than 80 characters are truncated by AnetHelpTool .    A valid topic title may contain alphanumeric
characters A-Z and 0-9.



Context String

Context string is an identifier for each topic in the Help system.    Each context string must be 
unique.    A given context string may be assigned to only one topic within the Help project; it 
cannot be used for any other topic.    Context string provides the way to make jumps from topic 
to topic or to display look-up boxes, such as word and phrase definitions.

Context strings are not case-sensitive and can be up to 80 characters in length.    Valid context 
strings may contain the alphabetic characters A-Z, the numeric characters 0-9, and the 
underscore (_).



Keyword

WinHelp application allows users to search for topics with the use of keywords assigned to the 
topics.    When the user searches for a topic by keyword, WinHelp matches the entered word to 
keywords assigned to specific topics.    If more than one keyword is defined for a topic, a search 
is performed on all of them.    WinHelp then lists matching topics by their titles in the Search 
dialog box.    More than one topic can have the same keyword.    Because a keyword is a fast 
way to access Help topics, it is convenient to assign keywords to most topics in a Help system.   

Keyword field consists of any combination of characters including spaces.    Keyword string can 
be up to 80 characters in length.



System Requirements

Hardware Requirements

Personal Computer using an 80386 or higher microprocessor.

2 MB RAM (4 MB recommended)

EGA, VGA, super VGA, XGA, 8514/A or compatible video graphics card.

Mouse.

Software Requirements

MS DOS operating system version 3.1 or later.
Microsoft Windows version 3.1 or later.
Microsoft Windows Help Compiler version 3.1 or higher.



Toggles boldness of a selection.



Toggles between regular and italic font styles.



Toggles underline feature of a selection.



Toggles strikethrough feature of a selection.



Calls Insert Objects dialog box to insert an object in cursor position.



Calls Color dialog box to change color of a selection.



Toggles the shadow feature of a selection.



Justify a paragraph to the left margin.



Justify a paragraph to the right margin.



Center a paragraph. Centered paragraph 
keeps    the    feature even if window is resized.



Justify both left and right edges of a paragraph.    
Note, Help Compiler does not support this feature.



Nonscrolling Region

Nonscrolling region (NSR) may contain text or graphic which has a fixed location at the top of a 
topic.    Even if the topic is more than a full screen you can scroll throughout the main window 
with the NSR staying in place.    Note that a NSR can be created only if the topic containing NSR
will be displayed as a jump window, not a pop-up.
To create a NSR select "Nonscrolling Region" check box in a Topic dialog box. 



Remove subscript or superscript feature of a selection.



Make selection a subscript.



Make selection a superscript.



Creating New Topic
Insert Image
Change Font and Font Attributes
Format Paragraph



Menu Commands
File Menu
Mode Menu
Edit Menu
Format Menu
Link Menu
Topic Menu
History Menu
Options Menu
Compile Menu
Help Menu



File menu

New...
Open...
Save
Save as...
Compact...
Repair...
Information
Exit



New Command (File menu)

Open a new help project file and save the current one.



Open Command (File menu)

Load a help project file (with .MDB extension)
and save the current one.



Save Command (File menu)

Compact and save the current help project file.



Save as Command (File menu)

Compact and save the current help project file under different name.



Compact Command (File menu)

Defragment the help project file (with .MDB extension). 
The compacted project typically shows better performance. 



Repair Command (File menu)

Repair corrupted project file.    Project file may
become corrupted if AnetHelpTool quits unexpectedly.



Exit Command (File menu)

Save current help project file and quit the program.



Information Command (File menu)

Information on current help project file. 



Mode menu

Design
Runtime



Design Command (Mode menu)

Toggle to Design mode. 
Enables editing a help project. 



Runtime Command (Mode menu)

Toggle to Runtime Mode.
Runtime Mode enables performance of following tasks:

- hot testing of a help project;
- making output help file.



Edit menu

Undo
Cut
Copy
Paste
Insert Object...



Undo Command (Edit menu)

Use Undo to reverse unwanted recent changes.    
Current project changes to last saved project file. 



Cut Command (Edit menu)

Cut selection and place it on a Clipboard.



Copy Command (Edit menu)

Copy selection and place on a Clipboard.



Paste Command (Edit menu)

Paste selection from a Clipboard to the cursor position. 



Insert Object Command (Edit menu)

Open Insert Object dialog box to place graphic object into the Help topic text.



Format menu

Font...
Color...
Shadow
Underline
Strikethrough
Paragraph



Font Command (Format menu)

Open a dialog box to change font attributes for a selection.



Color Command (Format menu)

Open a Color dialog box to change color of a selection.



Shadow Command (Format menu)

Toggles the shadow feature of a selection.



Underline Command (Format menu)

Toggles the underline feature of a selection.



Strikethrough Command (Format menu)

Toggles strikethrough feature of a selection.



Paragraph Command (Format menu)

Open a Paragraph dialog box to set specific paragraph attributes for current paragraph or for 
selected text .



Link menu

To Topic
To Program
Jump
Remove



To Topic Command (Link menu)

Open a Create New Link dialog box to make reference link between a particular topic and a 
selection.



To Program Command (Link menu)

Open a Link to Program dialog box to make reference link
of a selection with an executable program.



Jump Command (Link menu)

Make jump to destination topic.
Use this option to trace a link in Design mode.



Remove Command (Link menu)

Delete all reference connections of a selected hotspot.



Topic menu

New...
Attributes...
Delete...
Search...
Browse...
Browse Sequences...
Next
Previous



New Command (Topic menu)

Open Create New Topic dialog box to create new topic sheet.



Attributes Command (Topic Menu)

Open a Topic Attributes dialog box to edit topic attributes.



Delete Command (Topic Menu)

Open a Delete Topic dialog box to remove any specified topic.



Search Command (Topic Menu)

Open a Search dialog box to search topic from a keyword.



Browse Command (Topic Menu)

Open a Browse dialog box to jump to any topic from the list.



Next Command (Topic Menu)

Save the current topic and display the next one.



Previous Command (Topic Menu)

Save the current topic and display the preceding one.



History menu

Content
History List
Back



Contents Command (History menu)

Make jump to Contents.



History List Command (History menu)

Displays the history list, which shows the last 40 topics the 
user has viewed since opening a Help file in Windows Help.



Forward Command (History menu)

Display the topic next to current from History List.



Back Command (History menu)

Display the previous topic in the Back List.    The Back list includes the last 40 topics the user 
has displayed since opening current project help file.



Options menu

Open an Options dialog box to set operational parameters.



Compile menu

Create RTF, HPJ and H files
Compile
Run WinHelp
Batch Processing



Create RTF, HPJ and H files Command (Compile menu)

Prepare files necessary for Help Compiler to run.



Compile Command (Compile menu)

Run Help Compiler to make output help file.    The Help 
Compiler uses last created .RTF and .HPJ input files.



Run WinHelp Command (Compile menu)

Run Windows WinHelp.exe to display 
last created output help file.



Batch Processing Command (Compile menu)

Perform creation of all necessary intermediate .RTF, .HPJ and .H files, make output help file and
run Windows WinHelp.exe    to display last created output help file.



Help menu

Contents
About...



Contents Command (Help menu)

Run Windows WinHelp program
to display contents for AnetHelpTool Help.



About Command (Help menu)

Display copyright information.



How to Make Context Sensitive Help calls

Context sensitive help call provides connection between the user's actual working situation and 
the associated help topic.    It lets the user press F1 for Help on the item that currently has the 
focus.

AnetHelpTool generates an include file (of .H format) to connect the help system with the 
programmer's application. You can view the .H file using e.g. Notepad.    AnetHelpTool assigns 
succeeding numbers to topic context strings.    The number is an output parameter which should
be assigned to the appropriate control context ID by application developer .



AnetHelpTool Proposal Features

Next version of AnetHelptool will support the following features:

1. Importing texts from RTF files (now you can do it by using Clipboard only).
2. Support for multyfiles Help project.      
3. Creation of Secondary Windows.
4. Build tags support.
5.Creation user menu and user buttons for Help file.
 



Gathering information for the Help topics. 
Planning the Help file.

Before you begin gathering information and planning your help system, you should classify the 
users to whom the help file is addressed.    Novice users need detailed information on the 
terminology, interface and accomplishing of a specific task.    Experienced users prefer to use a 
Help file to look up reference information.    If you are providing Help file for all types of users 
you need to document all application-specific features, functions, statements, syntax and other 
relevant aspects. 

A help system should include Help topics, a contents screen and a keyword list. 
First of all you should identify the topics you want to include into the Help system.    Plan the 
contents screen to provide an overview for the Help system.    The contents screen appears first 
when the help file is run.    AnetHelpTool considers the first topic created as the contents screen 
topic.    Then you should decide how to combine these topics into a useble structure.    Keywords
assigned to topics help to find a specific piece of information quickly. 



Who are we?

This product is copyrighted by

                                (C) Anet Inc., 1995

Contact Information:

                                Anet Inc.
1070 Quartermaster Canyon
San Ramon, CA      94583
U.S.A.
Phone: 800-434-3439 or

510-735-1173
FAX: 510-743-1687
E-Mail: 70651.1125@compuserve.com



Distribution Notes

This product is distributed in the following files:

AHTOOL3.EXE
AHTOOL3.HLP
ATX30H.VBX
CMDIALOG.VBX
CMDIALOG.DLL
HC31.PIF
LSTR.DLL
MSAJT112.DLL
MSAJT200.DLL
THREEDVBX
VBDB300.DLL
VBRUN300.DLL



Create New Link Dialog Box
To Topic Command    (Link menu)

Enables link to selected phrase with some topic. 

To call this dialog box select phrase you want to make cross-reference link in topic text and click
To Topic command from Link menu.

 Box Options

 Come From
Displays title of topic where jump term is placed.
 Hotspot

Displays jump phrase itself.
 Go to      

Text box displays title of topic that is the target of the jump.
 Topics      

Lists all topic titles except current one.    Select target topic and doubleclick.
 Topic Preview      

Displays the context of topic highlighted in the Topics list if Show text options is checked.
 Jump
 Destination topic will be displayed in normal topic window.

 Pop-up
 Destination topic will be displayed in pop-up window.
 Show Text
 Makes visible Topic Preview    box.
 Makes invisible Topic Preview    box.



Delete Topic(s) Dialog Box
Pargraph Command (Format Menu)

Deletes any topic(s).

 Box Options

 Topics 
Select topic you want to delete and doubleclick it or press    --->    button.    Highlighted topic will 
be placed into Remove Topic(s) list.
 Remove Topic(s)

Lists    topics you want to delete.    To return topic to the Topics list select this topic and 
doubleclick it or press    <---    button.

 Command Buttons

 Preview 
Shows the context of    topic highlighted in the Topics or Remove Topic(s) lists in the top text 
box.
 --->

Moves highlighted topic from Topics list into the Remove Topic(s) list.
 <---

Moves highlighted topic from Remove Topic(s) list into the Topics list.



Font Color Dialog Box
Color command (Format Menu)

 Button

Change font color either for the text selection or for the font used thereafter in the new 
paragraph. 

 Box Options

 Colors 
Select button with color you want to assign and    push OK button.



Browse Topics Dialog Box
Browse Command (Topic Menu)

Enables user to navigate through the topics.    Double clicking on any item will jump to that topic.



Link to Program Dialog Box
To Program Command (Link Menu)

Links any executable program ( .bat, .com, .exe, or .pif files) with selected phrase.

 Box Options

 Program name
Enter the program name you want to link with selected phrase in the topic window.    You can 
type program name into the text box or use Browse button to select program in the Browse 
Dialog box.
 Command line

Enter command line for pogram in the Program name text box.    The command line text is 
optional. 

 Command Buttons

 Browse
Opens Browse Dialog box that allow you to select program name.

See also Making and Removing Links.



Tabs Dialog Box
Tabs Command (Format Menu)

Controls the position and alignment of tab stops.

 Box Options

 Tab Stop Position
Lists any tab stops that are set in the current paragraph or in    the selected paragraphs. 
To create a new tab stop, press Set button and    type the measurement. 
To change a tab stop, select it and then type a measurement.
To delete a tab select it and press Clear button.
 Default Tab Stops

Indicates the spacing between the default tab stops.
Microsoft Help Compiler sets all default tab stops to the value 1.27 inch, so this field cannot be 
edited.
 Tab Stops To Be Cleared

Lists the tab stops that will be cleared when you choose the OK button.
 Alignment

Indicates the alignment of text at the highlighted tab stop.
 Left

Extends text to the right from the tab stop.
 Center

Centers text at the tab stop.
 Right

Extends text to the left from the tab stop.    If text fills the space to the left of the tab stop, the text
often extends to the right.

 Command Buttons

 Set
Adds selected tab stop position in the Tab Stop Position box.    The new tab stop assumes the 
selected Alignment option.  
 Clear

Removes the position selected in the Tab Stop Position box from Tab list and inserts it next to 
Tab Stops To Be Cleared. 
 Clear All

Removes all custom tab stops from Tab list.

See also    Paragraph Formatting.

 



History Dialog Box
History List Command (History Menu)

The History list contains the Topic titles presented in the order viewed.    You can jump to any of 
them by double clicking or by    pressing Enter.



Paragraph Dialog Box
Paragraph Command (Fomat menu)

Modifies paragraph indents, text alignment, and paragraph spacing for current or selected 
paragraphs.

 Box Options
 Units

Select measurement you want to have for all paragraph and tab settings.
 Indentation

Determines the position of text in relation to the left and right margins.
 Left

Type or select the distance you want to indent a paragraph from the left margin. 
 Right

Type or select the distance you want to indent a paragraph from the right margin. 
 First Line

Type or select the distance you want to indent the first line of each selected paragraph from the 
left indent.
 Spacing

Determines the amount of space between paragraphs.
Before

Type or select the amount of space you want above the first line of each selected paragraph. 
The amount must be a positive decimal measurement.
 After

Type or select the amount of space you want below the last line of each selected paragraph.    
The amount must be a positive decimal measurement.
 Alignment

Determines the position of a paragraph text in relation to the indents.    To align text relative to 
the left and right margins, make sure that the paragraphs are not indented.
 Left

Aligns text of paragraphs at the left indentation.
 Centered

Centers text of paragraphs between the left and right indentations.
 Right

Aligns text of paragraphs at the right indentation. 
 Justified

Expands spaces in the lines to align text evenly between the left and 
right indentations.
Note. Microsoft Help Compiler ignores this setting.
 Command Buttons

See also Paragraph Formatting.



Insert Objects Dialog Box
Insert Object Command (Edit Menu)

 Button

Includes graphics into a topic text.

 Box Options

 Alignment
Sets the alignment options for displaying text and graphics if you want to include graphics as 
Reference. 
 As Character

Aligns the graphic as character.    Includes into text a reference of bmc filename type.
 At Left Margin

Aligns the graphic at the right margin.    Text wraps along the graphic's left edge.    Includes into 
text a reference of bml filename type.
 At Right Margin

Aligns the graphic at the right margin.    Text wraps along the graphic's left edge.    Includes into 
text a reference of bmr filename type.
 Insert as

Sets the method for including graphics in topic text.
 Object

Places graphics directly in topic text.
 Reference

Places graphic reference in topic text.
 Picture File Name

Type file name of graphical object you want to include in topic text or use Browse button to 
select file in the Browse Dialog box.

 Command Buttons

 Browse
Opens Browse Dialog box that allows you to select picture file name.

 Preview 
Displays picture from Picture File Name text box in the picture box.

See also Inserting Graphical Objects.



Options Dialog Box
Options Menu

 Box Options

 Autosave 
Each time you leave the Topic:
 the program will save topic text automatically.
 the dialog box will offer you the alternative to save the topic or skip the changes.

 Sort Topic Lists
 All topic lists in the program will be sorted by topic title.
 Topic lists will be sorted by time of creation.

 StartUp mode 
Determines the default mode for the AnetHelpTool being launched.
 Runtime

Any project file will load in Runtime Mode. 
 Design

Any project file will load in Design Mode. 

 Directories
Defines directories where you want to work.

  Source directory - Default directory for the AnetHelpTool    file dialog boxes.    For 
example, when you select Open command from the File menu, the dialog box will display 
the files of the Source directory.

 Output directory - Directory AnetHelpTool uses to store its intermediate files (.RTF, .H, .HPJ, 
etc.).

 Picture Directories
If you use inserting graphic by reference, you should appoint in this box the directories where 
referenced picture file is located.    This box is updated automatically when you insert graphic 
using Insert graphic dialog box.    You may correct or update this box manually.    Sequential 
directories should be separated by commas.

 Current Help Project Title
Enter the title of current help project title.    This text will be the title of the help file compiled 
by Help Compiler from your help project.



Search Dialog Box
Search Command (Topic Menu)

This dialog box displays all your    Keywords    and their interconnections with Topic titles    just as
it will be displayed in the compiled Help file.



Edit Topic(s) Attributes Dialog Box
Attributes Command (Topic Menu)
Create New Topic Dialog Box
New Command (Topic Menu)

Enables user to edit topics title, context string and keywords and defines whether or not topic 
will have a nonscrolling region.

 Box Options

 Title
Displays title of current topic.    You can edit topics title and/or select new current topic in the 
dropdown list (for Edit Topic(s) Attributes dialog box only).
 Context string

Type context string that will identify the current topic.    Valid context strings may contain the 
alphabetic characters A-Z, the numeric characters 0-9, and the underscore (_) and must be 
unique.
 Create nonscrolling area
 Current topic will have nonscrolling region.
 Current topic will have no nonscrolling region.
 Topics Keywords

Lists keywords assigned to the current topic. 
To add new keyword to the current topic push New button and type keyword in New Keyword 
text box.
Or move existing keyword from the Keywords List.    Select keyword in Keywords List and 
doubleclick it or push <---    button.
To edit keyword highlight it, push Edit button and edit keyword in Edit Keyword text box. 
To remove keyword from Topics Keywords list doubleclick it or highlight it and push --->    button.
 Keywords list

Lists all keywords in the help project file. 

 Command Buttons

 Show linked topics
Displays list of topics that have reference to current topic.
 Add    

Calls New Keyword box to add new keyword to Topics Keywords list.
 Delete

Deletes highlighted keyword from Keywords List box.
 Edit

Calls Edit Keyword box to edit highlighted keyword from Topics Keywords list.
 --->
Moves highlighted keyword from Topics Keywords list to the Keywords List.
 <---

Moves highlighted keyword from Keywords List to the Topics Keywords list.



Browse Sequences Command (Topic Menu)

Open Browse sequences dialog box that allows user to combine
topics in browse sequences.



Browse Sequences Dialog Box
Browse Sequences Command (Topic Menu)

Enables user to combine topics into browse sequences.

 Box Options

 Topics
Select topic to include in Browse sequence displayed in the Browse Sequences Box and 
doubleclick it or press ---> button.
 Browse Sequences
Lists and names Browse sequences being included in the current Help Project file.    You can 
create or delete Browse sequence, edit Browse sequence name and navigate through 
existing ones.
To create new Browse sequence press New button and edit default Browse sequence name 
in the text box.
To display browse sequence topics select desired one and doubleclick it or press Enter. 
 Current Browse Sequence
Lists topics to include in Browse sequence displayed in the Browse Sequences Box.    To 
move highlighted topic back in the Topics list doubleclick it or press <--- button.    You can also 
arrange topics by dragging selected topic and sort topics in alphabetical order by pressing 
Sort button.

 Command Buttons
 

 New    
Creates new Browse sequence and displays default name in the Browse Sequences box.

 Delete
Deletes Browse sequence from the Browse Sequences box.
 Sort
Sorts topics in the Current Browse Sequence box in alphabetical order.
 --->
Moves highlighted topic from Topic list to the end of Current Browse Sequence list.
 <---
Moves highlighted topic from Current Browse Sequence list to the Topic list.



Browse Sequence

Browse sequence is a group of Help topics that establishes a linear path through topics.    
There can be multiple browse sequences in a Help file, but each Help topic can belong to 
only one sequence.    You can move through help topics that are included in a browse 
sequence by pressing Browse buttons << and >>.



Tab Command (Topic menu)

Open Tabs dialog box that allows user to set tabulation
for current or selected paragraph(s).



Open a dialog box to change font
attributes for a selection.



Open Insert Object dialog box to place graphic
into the Help topic text.






